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1.Как построить в программе Microsoft Excel спектр ЭПР, представленный в 
текстовом формате (filename.txt). 
 
Для того, чтобы представить спектр ЭПР в программе Microsoft Excel необходимо:  
 
1. Открыть программу Microsoft Excel и выбрать опцию «Файл→Открыть» и найти свою папку в 
директории «CLIENT» на Рабочем столе. В данной директории пользователь организует свою личную 
папку, которую впоследствии использует для работы.  
 
2. Выбрать файл с интересующим спектром (предварительно рекомендуем в опции ТИП ФАЙЛА  
установить тип файла «Все файлы»). 
 
3. Выбрать файл, имеющий расширение .txt и нажать кнопку «Открыть» в данном диалоговом 
окне. Если все опции и настройки в программы Microsoft Excel выбраны правильно, в результате 
проделанных операций на экране появляется диалоговое окно импорта спектра ЭПР, представленное на 
рис. 1. В противном случае следует обратится к специалисту РЦ. 
 

 
Рис. 1. 
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4. Нажимая копку «Готово» (отмечен красной стрелкой на рис. 1), пользователь получает 
следующий экран – рис. 2, где в таблице Excel в столбце А отражен порядковый номер точки в спектре, 
в столбце B – магнитная индукция в Гауссах и в столбце C – амплитуда сигнала в условных единицах, 
соответствующая данному значению магнитного поля.  
 

 
Рис. 2. 

 
Для работы столбец А и строки номер 1 и 2 не нужны. Их желательно удалить для повышения удобства 
работы с полученным массивом данных. В результате Вы получите следующий экран – рис. 3. 
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Рис. 3. 

 
5. В связи с особенностью версии программы Microsoft Excel, установленной на компьютере 
пользователя ЭПР в РЦ МРМИ, следует выделить таблицу, используя опции «Найти и Заменить» и 
произвести замену всех точек в качестве разделителей разрядов на запятые.  
 
После этого выделите всю таблицу и представьте данные в числовом формате. Для удобства восприятия 
данных рекомендуем в столбце А задать 1 знак после запятой, а в столбце В – два знака после запятой – 
рис. 4. 
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Рис. 4. 

 
6. Для построения спектра следует выделить столбец А и В. И выбрать во вкладке главного меню 
«Вставка» тип гистограммы «Точечная с гладкими кривыми» - рис. 5. 
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Рис. 5. 

 
В результате на экране появляется график нужного спектра ЭПР – рис. 6 – который пользователь может 
самостоятельно редактировать. 



7 
 

 
Рис. 6. 
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2. Как построить в программе Microsoft Excel спектр ЭПР, представленный 
в текстовом формате (filename.asc). 
 
Для того, чтобы представить спектр ЭПР в программе Microsoft Excel необходимо:  
 

1. Открыть программу Microsoft Excel и выбрать опцию «Файл→Открыть» и найти свою папку в 
директории «CLIENT» на Рабочем столе. В данной директории пользователь организует свою 
личную папку, которую впоследствии использует для работы.   

 
2. Выбрать файл с интересующим пользователя спектром (предварительно рекомендуем в опции 

ТИП ФАЙЛА  установить тип файла «Все файлы»). 
 

Выбрать файл, имеющий расширение .asc и нажать «Открыть». Если все опции и настройки в 
программe Microsoft Excel выбраны правильно, в результате проделанных операций должен 
получиться экран, представленный на рис. 7. В противном случае следует обратиться к специалисту 
РЦ. 

 

 
Рис. 7 

 
3. Нажать копку «Готово» и в результате получить следующий экран – рис. 8, где в таблице Excel в 

столбце А отражено магнитная индукция (в Гауссах) и в столбце В – амплитуда сигнала в 
условных единицах, соответствующая данному значению магнитного поля.  
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Рис. 8 

 
Для работы строки номер 1, 2 и 3 не нужны. Их желательно удалить для повышения удобства работы с 
полученным массивом данных. В результате получается следующий экран – рис. 9. 
 

 
Рис. 9 

 
4. В связи с особенностью версии программы Microsoft Excel, установленной на компьютере для 

пользователей в РЦ МРМИ, следует выделить таблицу, и, используя опции «Найти и 
Заменить» и произвести замену всех точек в качестве разделителей разрядов на запятые.  
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После этого необходимо выделить всю таблицу и представить данные в числовом формате. Для 
удобства восприятия данных рекомендуем в столбце А задать 1 знак после запятой, а в столбце В – два 
знака после запятой – рис. 10. 
 

 
Рис. 10 

 
5. Для построения спектра следует выделить столбец А и В. И выбрать во вкладке главного меню 
«Вставка» тип гистограммы «Точечная с гладкими кривыми» - рис. 11. 

 

 
Рис. 11 
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В результате Вы получите следующий экран – рис. 12. 
 

 
Рис. 12 
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3. Как построить в программном пакете Origin 9 спектр ЭПР, 
представленный в текстовом формате (filename.txt). 
 
Для того, чтобы представить спектр ЭПР в программном пакете Origin 9 необходимо:  
 
1. Открыть программу Origin 9 и выбрать опцию «File→Import» и выбрать тип импортируемых 
данных «Single ASCII» – Рис.13 
 

 
Рис. 13 

 
2. Найти свою папку в директории «CLIENT» на Рабочем столе. В данной директории 
пользователь организует свою личную папку, которую впоследствии использует для работы. В своей 
папке клиент выбирает файл с интересующим его спектром (предварительно рекомендуем в опции ТИП 
ФАЙЛА  установить тип файла «All files»). 
 
3. Требуется выбрать файл, имеющий расширение .txt и нажать «Open». Если все опции и 
настройки программы Origin 9 выбраны правильно, в результате проделанных операций пользователь 
получает экран, представленный на рис. 14. В противном случае следует обратится к специалисту РЦ.  
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Рис. 14 

4. В таблице программы Origin 9 в столбце А(X) указан порядковый номер точки в спектре, в 
столбце B(Y) – магнитная индукция (в Гауссах) и в столбце C(Y) – амплитуда сигнала в условных 
единицах, соответствующая данному значению магнитного поля.  
Для работы столбец А(X) не нужен. Его желательно удалить для повышения удобства работы с 
полученным массивом данных.  
5. Для того, чтобы построить график спектра в программе Origin необходимо задать для колонки 
B(Y) – магнитное поле, в Гауссах статус оси Х. Для этого надо щелкнуть правой кнопкой мыши по 
кнопке колонки В, и в раскрывающемся контекстном меню выбрать вкладку «Set As – X». 
6. Для построения спектра следует выделить столбцы B(X)  и C(Y).   
7. После выделения столбцов кликаем правой кнопкой мыши в выделенную область и в 
появившемся контекстном меню выбираем «Plot» → «Line» → «Line» – рис. 15. 
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Рис. 15 

Полученный результат приведен на рис. 16 
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Рис. 16 
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4. Как построить в программе Bruker WinEPR Processing спектр ЭПР, 
представленный в формате спектра Bruker XEPR  (бинарный файл 

filename.dsc и filename.dat ) 
 
Для того, чтобы представить спектр ЭПР в Bruker WinEPR Processing необходимо:  
 
1. Открыть программу Bruker WinEPR Acquisition и активизировать опцию «File→Open». 
 
2. В открывшемся окне выбрать Тип файла – «BEST Spectra» – рис.17.  В папке «CLIENT» на 
Рабочем столе выбрать свою папку и найти в ней файл интересующего Вас спектра с расширением  
filename.dsc. В результате нажатия клавиши «Открыть» произойдет загрузка требуемого файла в 
программу Bruker WinEPR Acquisition. 
 
 

 
Рис. 17 

 
3. В результате на экране программы Bruker WinEPR Acquisition появится требуемый спектр – рис. 
18. Для того, чтобы перейти к его редактированию в программе Bruker WinEPR Processing необходимо 
нажать кнопку WinEPR в правой верхней части главного меню программы Bruker WinEPR Acquisition 
(отмечена на рис. 18 черной стрелкой). 
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Рис. 18 

 
4. Для того, чтобы начать работу с данным файлом, необходимо в программе Bruker WinEPR 
Processing активизировать опцию «WINEPR System  →  1D Processing» – рис. 19. В результате на 
экране появится исходный спектр. Если этого не произошло, обратитесь к специалисту РЦ. 
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Рис. 19 
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5. Как произвести определение и удаление базовой линии по заданным 
точкам в спектре при помощи программы Bruker WinEPR Processing. 

Для того, чтобы в программе Bruker WinEPR Processing произвести учет и вычитание базовой 
линии, требуется: 

 
1. Открыть файл с помощью программы Bruker WinEPR Acquisition (см. соответствующий раздел 
4_Как открыть для редактирования в программе Bruker WinEPR Processing  спектр ЭПР, полученный в 
программе XEpr). 
 

2. Для того, чтобы определить базовую линию спектра, необходимо выбрать опцию «1D 
Processing→Baseline Correction…». В результате программа переходит в режим работы с базовой 
линией - рис. 20. 
 
 

 
Рис. 20 

 
3. Для определения тех точек спектра, по которым будет производится расчет базовой линии, 
необходимо активизировать опцию «Baseline Correction→Define POINT». В результате данной 
операции  пользователь может путем нажатия левой кнопкой мыши возможно выбрать до 50 точек для 
последующего расчета базовой линии. При этом выбранные точки отмечаются красным  – рис. 21.  На 
этом рисунке черными стрелками отмечены области, где находятся точки, выделенные красным для 
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расчета базовой линии. Выбор точек, которые необходимо включить в расчёт базовой линии, 
определяется в зависимости от условий эксперимента для получения линейной базовой линии и так, 
чтобы не затрагивать сигнал спектра ЭПР. 
 
 

 
Рис. 21 

 
Замечание: 
 Отменить выбор предыдущей точки можно путем нажатия правой кнопкой мыши. 
 Для расчета базовой линии не имеет значения, в каком порядке будут выбраны точки спектра. 
 
4. Для того, чтобы определить те области спектра, все точки которых будут использоваться для 
расчета базовой линии необходимо необходимо выбрать опцию «Baseline Correction→Define 
Region». Далее, перемещая левой кнопки мыши линии определить необходимые области спектра – 
рис.22.  
Переключение между левой и правой линией границы осуществляется нажатием левой кнопкой мыши. 
Завершение выбора областей спектра  для последующего расчета базовой линии осуществляется 
нажатием правой кнопки мыши. Повторное нажатие правой кнопкой мыши убирает выделение участка 
спектра, сделанное последним. Таким образом можно выделить до 10 регионов в спектре.  
 
После этого можно выбрать еще одну область спектра для расчета базовой линии, а отмеченный 
участок будет выделен снизу красной линией (на рис. 22 она отмечена черной стрелкой).  
 
Завершается процесс выделения регионов нажатием клавиш SHIFT + ESC. 
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Рис. 22 

 
Обращаем Ваше внимание, что необходимо выбрать опцию «Baseline Correction→Function-
Extrapolate» для того, чтобы вместо расчета базовой линии только в предварительно выделенной 
области, экстраполировать рассчитанную базовую линию на весь спектр. 
 
5. Далее необходимо выбрать подходящий тип функции для расчета базовой линии из списка 
доступных функций. Данный список доступен при выборе параметров меню  «Baseline 
Correction→Function - …» 
 

- Two Point - первая и последняя точки спектра будут соединены прямой линией. Все остальные 
отмеченные точки игнорируются. Этот режим доступен только при определении базовой линии 
по точкам спектра, но не в случае построения базовой линии по выделенным участкам спектра. 
 
- Point to Point - выбранные точки спектра будут соединены прямыми линиями. Этот режим 
также доступен только при определении базовой линии по точкам спектра, но не в случае 
построения базовой линии по выделенным участкам спектра. 
 
- Cubic Spline Эта опция соединяет отмеченные точки спектра кубическим сплайном. 
Ограничивающее условие для применения данного алгоритма состоит в том, чтобы эта функция 
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была устойчива в данной точке. Результирующая базовая линия проходит через каждую 
отмеченную точку. 
 
- Constant - полиномиальный алгоритм расчета базовой линии.  
 
- Linear - полиномиальный алгоритм расчета базовой линии.  
 
При выделении достаточного количества точек для расчета базовой линии доступны также 
следующие полиномиальные способы определения базовой линии: 
 
- Quadratic 
- Cubic 
- 4-th Order 
- 5-th Order 
- 6-th Order 

 
После выбора всех необходимых параметров и получения базовой линии, которая представлена красной 
линией поверх исходного спектра (рис. 24) становится доступна операция вычитания полученной 
базовой линии из исходного спектра. В данном случае был использован полином - 5-th Order, так как 
при вычитании данной базовой линии наилучшим образом получается привести к нулевому значению 
те участки спектра ЭПР, где нет полезного сигнала. 
 

 
Рис. 24 
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Для вычитания базовой линии необходимо активизировать опцию «Baseline 
Correction→Substract». Результат проделанной операции приведен на рис.25 

 

 
Рис. 25 

 
6. Для того, чтобы вернуться в режим 1D Processing, необходимо активизировать опцию «Baseline 

Correction→Return» . 
 

7. Для сохранения спектра, полученного после вычитания базовой линии, необходимо активизировать 
опцию «File → Save as…». Файл спектр будет сохранен в виде бинарного файла с расширениями .par 
и .spc. 
 

8. Для их конвертации файл спектра в формат ASCII необходимо открыть в программе Bruker WinEPR 
Acquisition и воспользоваться опцией меню «File → Export…». Полученный спектр будет сохранен в 
текстовом формате c расширением .asc – рис. 26. 
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Рис. 26 
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6. Как определить значение g-фактора в программном пакете Bruker WinEPR 
для спектра ЭПР, представленного в формате  Bruker XEPR  (бинарный файл 

filename.dsc и filename.dat) или Bruker WinEPR (бинарный файл filename.par и 
filename.spc) 

 
Для того, чтобы определить значение g-фактора в программном пакете Bruker WinEPR для спектра ЭПР, 
представленный в формате спектра Bruker XEPR  (бинарный файл filename.dsc и filename.dat), 
необходимо:  

 
1. Открыть программу Bruker WinEPR Acquisition и активизировать опцию «File → Open». 

 
2. В открывшемся окне выбрать Тип файла – «BEST Spectra» – рис.27.  В директории «CLIENT» 

на Рабочем столе выбрать свою папку и найти в ней файл интересующего спектра с расширением  
filename.dsc. В результате нажатия клавиши Открыть произойдет загрузка требуемого файла в 
программу Bruker WinEPR Acquisition. 

 

 
Рис.27 

 
В случае, если коррекция базовой линии была произведена в программном пакете Bruker WinEPR и 
полученный файл был сохранен в виде бинарного файла с расширениями filename.par и filename.spc 
(смотрите раздел Как произвести определение и удаление базовой линии по заданным точкам в спектре 

при помощи программы Bruker WinEPR Processing), то в окне открытия нужного файла спектра 

необходимо выбрать файл с расширением .par. 

В результате на экране будет представлен требуемый спектр – рис. 28. 
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Рис.28 

3. Далее необходимо выбрать опции «View → X-Axis Unit → g-Factor» – рис. 29. 

 

Рис. 29 

В результате в правом нижнем углу окна программы Bruker WinEPR Acquisition при наведении курсора 
на точку спектра будет отображаться значение соответствующего g-фактора – рис. 30. 
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Рис. 30 

4. Для повышения точности определения g-фактора необходимо активировать опцию – «Курсор в 
виде линии». Для этого нужно нажать на соответствующую кнопку в главном меню программы 
Bruker WinEPR Acquisition (она отмечена красной стрелкой на рис. 30). В результате передвигая 
курсор можно определить g-фактор любой точки спектра – рис. 31. 

 

 
Рис. 31 
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Замечание – обратите внимание, что значение g-фактора определяется с учетом параметров, 
автоматически полученных из файла описания параметров спектра filename.dat (спектр в программе 
Bruker XEPR  сохраняется в виде бинарного файла filename.dsc (файл спектра) и filename.dat (файл 
параметров спектра)). Посмотреть параметры можно, выбрав опцию «Parameter → Experiment…» –
рис. 32. 

 

Рис. 32 
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7. Как определить ширину линии в программном пакете Bruker WinEPR для 
спектра ЭПР, представленный в формате спектра Bruker XEPR  (бинарный 
файл filename.dsc и filename.dat ). 
 
Для того, чтобы определить ширину линии в программном пакете Bruker WinEPR для спектра ЭПР, 
представленный в формате спектра Bruker XEPR  (бинарный файл filename.dsc и filename.dat), 
необходимо:  
 
1. Открыть файл с помощью программы Bruker WinEPR Acquisition (см. соответствующий раздел 

4_Как открыть для редактирования в программе Bruker WinEPR Processing  спектр ЭПР, полученный 

в программе XEpr) 
 

2. В полученном окне работы со спектром в программе Bruker WinEPR Processing выбрать опцию 
Display → Distance… (рис. 33). 

 

Рис. 33 
 

3. В результате на экране появится вертикальная линия для определения первой точки отрезка для 
определения ширины линии спектра ЭПР – рис. 34. Фиксация данной точки осуществляется нажатием 
левой кнопки мыши. 
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Рис. 34 

4. Далее необходимо перемещением второй линии определить ширину спектра ЭПР – рис. 35 
 

 
Рис. 35 
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Обратите внимание, что при нажатии левой кнопки мыши мы можем фиксировать как левую, так и 
правую линию для определения ширины линии, производя таким образом переключение между ними 
для улучшения точности. 

5. Выход из режима определения ширины осуществляется путем снятия флажка Distance... в 
соответствующем параметре меню – рис. 36 
 

 
 

Рис. 36 
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8. Как сгладить шумы в программе Bruker WinEPR Processing методом 
скользящего среднего (Moving Average). 

Для того, чтобы в программе Bruker WinEPR Processing произвести сглаживание шумов спектра 
методом скользящего среднего, требуется: 

 
1. Открыть программу Bruker WinEPR Processing и активизировать опцию «File → Load». 

 
2.  В директории «CLIENT» на Рабочем столе выбрать свою папку и найти в ней файл 

интересующего нас спектра с расширением filename.spc. В результате произойдет загрузка 
требуемого файла в программу Bruker WinEPR Processing. 

 
3. Для того, чтобы начать работу с данным файлом, необходимо выбрать опцию «WINEPR 

System  →  1D Processing». В результате на экране появится исходный спектр – рис. 37. 
 

 
Рис. 37 

 
6. Для того, чтобы открыть диалоговое окно сглаживания шумов с помощью фильтра «Скользящее 

среднее» (Moving Average), необходимо активизировать опцию «1D Processing → Filter…». 
 
7. В открывшемся в результате данных операций диалоговом окне – рис.38 - необходимо установить 

количество точек выборки n  начиная от трех точек и выбрать тип фильтра Moving Average. 
Используя метод скользящей средней, разрешено устанавливать число точек выборки не выше, чем 
15, но оно должно быть нечетным.  

 
Если шаг скользящей средней выражен четным числом, то полученные скользящие 
средние центрируют. Операция центрирования заключается в повторном скольжении с шагом, 
равным двум. Число уровней сглаженного ряда будет меньше на величину шага скользящей средней. 
В алгоритме Moving Average программы Bruker WinEPR Processing не предусмотрена операция 
центрирования, поэтому n обязательно должно быть нечетным 
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Рис. 38 

 

Замечание: Алгоритм вычисления по методу скользящего среднего представляет собой вычисление 
значение среднего арифметического по выборке из n точек: 

 

Где: 					 –  j-ая точка;  
n – число точек в выборке. 

 
Как первая, так и последняя из  (n - 1) / 2 точек исходного спектра не могут быть вычислены, поэтому 
им присваиваются значения первого и последнего значений в рассчитываемом интервале. 
 

 
8. В нашем примере на рис. 39 в результате произведенного сглаживания шумов спектра методом 

скользящего среднего (Moving Average) для n = 15. 
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Рис. 39 
 
 

Для того, чтобы в дальнейшем использовать полученный сглаженный спектр ЭПР в других программах 
для обработки данных, необходимо сохранить полученный спектр в формате filename.spc и 
конвертировать в формат ASCII в программе Bruker WinEPR Acquisition програмного пакета Bruker 
WinEPR. 

 
Сравнение исходного спектра ЭПР и спектра ЭПР,  полученного в результате сглаживания шумов 
методом скользящего среднего приведен на рис. 40. Спектры построены в программе Origin 9. 
 

 
Рис. 40 
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9. Как распечатать спектр в программе Bruker WinEPR Processing. 

Для того, чтобы  вывести на печать спектр в программе Bruker WinEPR Processing  необходимо 
необходимо выбрать опцию File- Print Preview. Полученный результат представлен на рис. 41. 

 

Рис. 41 

2. Для того, чтобы перед выводом спектра на печать выбрать наиболее подходящий способ 
расположения на листе печати, а также ориентацию рисунка на странице и другие параметры печати, 
необходимо в открытом окне предварительного просмотра спектра активизировать опцию Print Set Up 
– рис. 42. 
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Рис. 42 

Актирование опции Print запускает подготовку страницы для печати в соответствии с параметрами 
настройки принтера и запускает принтер. 

Для выхода из режима настройки печати спектра в программе Bruker WinEPR Processing  необходимо 
активизировать опцию Return. 
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10. Как копировать в буфер обмена в формате рисунка спектр в программе 
Bruker WinEPR Processing. 

Актирование опции File- Copy в программе Bruker WinEPR Processing  позволяет копировать данные в 
буфере обмена WINDOWS в формате рисунка.  

Таким образом, это можно получить спектры в текстовый процессор в формате картинки.  

Есть довольно много приложений, которые поддерживают обмен данными с использованием буфера 
обмена. (Т.е. MSWrite, MS-Office). 

Для его вставки нужно воспользоваться стандартной командой вставки данных из буфера обмена для 
всех приложений WINDOWS. Полученный результат для программы Microsoft Word приведен на рис. 
43. 

.  

Рис. 43 

 


